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Course Overview 

Overview 

The goal of this course is to provide you with the skills and knowledge necessary to create 

and modify ad hoc reports required for your role. 

Requirements 

You must have completed the Overview of InfoView Reporting course before taking this 

training. 

Objectives 

After completing this course, you should be able to: 

 

 Log on to Desktop Intelligence 

 Create an ad hoc report 

 Format a report 

 Sort data in a report 

 Apply a section break 

 Outline data 

 Create and modify a chart 

 Create a crosstab 

 Add a rank 

 Add an alerter 

 Use drill-down mode 

 Insert calculations 

 Add free-standing cells 

 Import a report from the repository 

 Export data 

 

Agenda 

Topic Time in Minutes 

Welcome and Introductions 10 

Course Overview 5 

Getting Started 10 

Logging on to Desktop Intelligence 5 

Desktop Intelligence Layout 20 
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Topic Time in Minutes 

Creating an Ad Hoc Report 45 

Break 15 

Formatting a Report 15 

Sorting Data 15 

Applying a Section Break 20 

Outlining Data 15 

Creating and Modifying a Chart 20 

Creating a Crosstab 20 

Lunch Break 60 

Adding a Rank 20 

Adding an Alerter 20 

Using Drill-Down Mode 20 

Break 15 

Inserting Calculations 25 

Adding Free-Standing Cells 15 

Importing a Report from the Repository 10 

Exporting Data 10 

Review 10 

Total 420 
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Getting Started 

Overview 

In this topic, you learn descriptions of Desktop Intelligence and BusinessObjects 

terminology. 

For your convenience and future reference, report categories for BIAR, MAR, and SUR are 

also provided. 

Desktop Intelligence 

Desktop Intelligence is a BusinessObjects application with a graphical user interface that 

gives you access to detailed data in the BIAR data warehouse. 

The Query panel contains non-technical descriptions of each object available. Point-and-click 

functionality allows you to create queries, analyze data, and produce reports easily to meet 

your business needs. 

You can use Desktop Intelligence in online mode through InfoView, as you are doing in this 

course, or you can access the application directly on your computer. Either way, the 

application must be installed on your computer. 

 

IF you want to create and manage 
reports using: 

THEN use this mode: 

Data from the centralized database, known 

as the "BIAR data warehouse" 

Online 

Only data on your computer Offline 
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BusinessObjects Terminology 

The following terms are commonly used in Desktop Intelligence. Appendix A lists additional 

and more detailed terminology. 

 Universe: The database view that allows you to create queries and retrieve data 

 Classes: Logical groupings of data in each universe 

 Objects: Data elements that form classes; there are dimension, detail, and measure 

objects: 

o Dimension Object: Retrieves data that provides the basis for analysis in a report. 

Dimension objects typically retrieve character-type data, such as provider names. 

o Detail Object: Provides additional information. For example, an address is a detail 

object associated with a provider. Addresses provide additional information about 

providers. 

o Measure Object: Retrieves numeric data that is the result of calculations on data in 

the database. 

 

 

 
 

 

Document Versus Report 

In Desktop Intelligence, one or more reports represents a "document." A document may 

have multiple tabs, with each tab containing a different report or notes about the report(s). 

The structure is similar to an Excel file with multiple worksheets. 

Traditionally, this is the distinction between terms, but in the application itself, the terms 

are not used consistently. In practice, the terms are used interchangeably, as we are 

going to do in this course. 
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Report Blocks 

Each report tab contains a separate report block, and a cell is the most basic element in 

each block. 

These are the main block types: 

 Table: Has headings for columns 

 

 
 

 

 Crosstab: Has headings for columns and rows, and data at the intersection of the 

columns and rows 
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 Chart: Displays data graphically 

 

 
 

 

Query 

A query is a request for information that uses a specific set of instructions for extracting 

data from a database. 

You build a query containing objects from a universe and then run the query to retrieve 

data from the BIAR data warehouse to generate a report. This helps you to narrow data 

results to meet your specific reporting needs. 
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BIAR, MAR, and SUR Report Categories 

The following lists describe BIAR, MAR, and SUR report categories at a high level. 

BIAR: Generates reports that range from simple queries to more complex reporting and 

data analysis. General users can manage reports through InfoView and super users can 

create and modify ad hoc reports in Desktop Intelligence. 

 Balancing Reports: Reports in this category are reviewed after BIAR is loaded, and are 

used to validate the claim and non-claim loads. 

 

 BIAR Targeted Queries: Reports in this category focus on provider and recipient claim 

history, as well as home health visits. These are some of the items in the targeted 

reports: 

o Home health visits and costs by provider 

o Provider history, with detailed information about the provider, diagnosis, procedures, 

and places of service that have been used by a specific provider 

o Recipient history, with detailed information about medical visits, emergency room 

visits, and prescriptions 

 

 Executive Information System (EIS): Reports in this category provide high-level 

summary, aggregate-type data that is useful for executives or those in leadership 

positions. The reports display information such as: 

o Provider and recipient count information per county, with the ten counties having the 

lowest provider-to-recipient ratio identified at the top of the report 

o Trending data that summarizes eligible recipients by geography and Medicaid plan in 

three ways for a three-month period 

o Totals in a graphical format for the Nursing Facility Services Program to support 

legislature-appropriated funding 

o Paid claims by provider type for a calendar quarter for the present year and 

comparison data for the previous year 

o Summary information for payments by provider type 

o The number of providers in each status based on provider type within each county 

o A list of recipient and provider counts for each county 

o The top 20 providers ranked by number of claims processed for a specified date 

range 

o The top 25 NDC codes 

o Enrollment counts by assistance category 

o Summary information for pharmacy claims by specific therapeutic class for a 

payment date range, ordered by therapeutic class code and description 

 

 ODJFS Corporate Documents: Reports in this category were specifically requested by 

ODJFS. 
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MAR: These reports provide financial and statistical data to assist the state and federal 

government with fiscal planning, new program and policy development, and monitoring and 

controlling state medical assistance programs. You can find more detailed descriptions of 

each report in iTRACE. MAR reports are divided into three categories described below. 

 MAR Batch Reports: Accessed using FileNet (COLD) 

o Abortion Detail 

o Sterilization Detail 

o MAR Reconciliation 

o Default State Category of Service 

o Federal Reporting – Cash Recoupment Summary 

o Federal Reporting – Cash Recoupment Detail 

o Capitation Summary by Region 

o CMS 372 Annual Reports on HCBS Waivers 

 Assisted Living 

 Home Care Waiver 

 Individual Options Waiver 

 Level One Waiver 

 Choices Waiver 

 Passport Waiver 

 Transitions Aging Carve-Out Waiver 

 Transitions MRDD Waiver 

o Unknown MAS—BOE Assignment 

  

 MAR BusinessObjects Reports: Accessed using InfoView or Desktop Intelligence 

o MAR—Payment Register by Fund Code Group Reports 

 Money Follows the Person 

 Regular Medicaid Program 

 SCHIP Program 

 State Funds Only 

 Provider Type Reimbursement by Fund Code Summary 

o Ohio Medicaid Paid Claims Detail 

o Ohio Medicaid Paid Claims Summary 

 

Note: There are two MAR-related universes available for ad hoc querying in Desktop 

Intelligence: CMS 372 and MSIS. 

 

 MAR Online Panel Reports: Accessed using MAR interChange panels. These reports 

are divided into the following categories. 

o Expenditures: These reports analyze expenditures by benefit plan, aid category, 

COS, fund code, provider type, participation, and place of service. 

o Long Term Care: This category contains the Long Term by Revenue report. 

o Operations: Reports in this category provide analysis on filing errors, provider 

errors, as well as operational performance reports and throughput analysis reports. 

o Provider: These reports analyze provider participation, provider ranking, and 

payment comparisons by COS and provider type. The Third Party Payment Ranking 

report is also included in this category. 

o Recipient: This category contains Medicare A, B, and AB-related reports, as well as 

reports that analyze recipient ranking and participation. 
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SUR: Provides a statistical screening tool primarily designed to identify those providers with 

medical resource use that is substantially different from their peers. It provides an in-depth 

view of utilization patterns and associated costs and allows for profiling of providers and 

consumers. 

 Case Tracking: Reports in this category are useful to the SUR unit--specifically for the 

Case Tracking process. This information can be found in some of the Case Tracking 

reports: 

o Case Tracking information for cases in Open, Closed, and Purged status 

o Providers who have been suspended 

o Recipient Lock-In data 

 

 Random Sample Reports: This category contains the Random Sample Claim Detail 

report, which provides a detailed list of claims returned by a random-sample request. 

 

 SUR Profiler Reports: This category contains quarterly and yearly reports that assist 

with identifying providers who have medical resource use that is substantially different 

from their peers. 

 

 SUR Targeted Queries: This category contains pre-defined reports that identify specific 

questionable practice patterns and potential instances of fraud or abuse. Reports in this 

category display information such as: 

o Providers, without particular specialties, who bill certain MRI or CT scans during any 

one calendar quarter 

o All inpatient claims containing a surgical code where the surgical date is greater than 

the From Date of Service 

o A summary of all diagnosis codes billed by the criteria selected by the user for a 

specific time frame 

o Exception Professional claims submitted by a provider meeting the defined criteria 

for the report 

o Providers who bill a lower number of codes than their peers  

o Inpatient claims and home and community care service claims with overlapping time 

periods for the same recipient 

o Recipients who visited multiple pharmacies and multiple non-pharmacy providers for 

a given date-of-service range 

 

 
  

When you have access to Desktop Intelligence and a standard report 

does not meet your needs, you can either modify a standard report in 

Desktop Intelligence or create your own ad hoc report. 
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Check Your Understanding 

This activity contains questions to assess your understanding of key concepts in this topic. 

Review the topic if your score is below your standards. 

 

To create and modify ad hoc reports, you must have Desktop Intelligence 

installed on your computer. 

A. True 

B. False 

 

What is a universe in BusinessObjects? 

A. A series of tables in a database 

B. Database view that allows you to create queries 

C. Data elements that form groups of objects 

D. A group of modules within an application 

Summary 

In this topic, you learned descriptions of Desktop Intelligence and BusinessObjects 

terminology. Report categories for BIAR, MAR, and SUR were also provided for your 

convenience and future reference. 
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Logging on to Desktop Intelligence 

Overview 

In this topic, you learn how to log on to Desktop Intelligence. 

You can access Desktop Intelligence directly through your computer (offline) or through 

InfoView. In this training, you are only going to log on through InfoView; however, this 

topic describes both methods for your convenience and future reference. 

Who 

TBD 

When 

You can log on to Desktop Intelligence at any time, as long as you have the application 

installed on your computer and the appropriate logon information. If you want to work 

online through InfoView, you must also have Internet connectivity and the correct URL. 

 

 
   

You must log on at least once in online mode before you can log on in 

offline mode. 

 

 
   

You can only attempt to log on three times consecutively. If you try to 

use an incorrect password more than three times, your user ID is locked 

and you must contact your administrator. 

 

Requirements 

You must have this information to complete the topic: 

 InfoView URL 

 System name 

 Valid username and password 

 Authentication name 

 

 
  

The authentication method is how BusinessObjects communicates with 

security that is set up for interChange. In this training, we are using 

"Enterprise." For your job, the default selection is going to be "LDAP," 

which allows you to have the same user ID and password for InfoView 

and interChange. 
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How To 

Follow the steps in the tables below to log on to Desktop Intelligence using both methods. 

Logging on through InfoView 

Step Action 

1 Open Internet Explorer or an available browser with Internet connectivity. 

2 Access the InfoView URL. 

3 In the InfoView Logon window, type or select the applicable information for 

these fields: 

 System 

 User Name 

 Password 

 Authentication 

4 Click Logon.  

Note: The InfoView Home page displays. 

5 Select Desktop Intelligence in the New drop-down list or click New Desktop 

Intelligence Document in the workspace. 

6 If prompted with the New Report Wizard, click Cancel or proceed with the 

wizard. 
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Logging on Directly through Computer 

Step Action 

1 Click Start and follow these steps: 

a. Point to All Programs. 

b. Point to BusinessObjects XI 3.1. 

c. Point to BusinessObjects Enterprise. 

d. Select Desktop Intelligence. 

2 In the User Identification window, type or select the applicable information for 

these fields: 

 System 

 User Name 

 Password 

 Authentication 

3 Click OK. 

4 If prompted with the New Report Wizard, click Cancel or proceed with the 

wizard. 

 

 
  

When you access the InfoView Logon page, mark the page in your 

Internet Favorites folder. 

 

 
  

By default, the New Report Wizard displays when you open Desktop 

Intelligence. You can change this default setting by either deselecting 

Run this Wizard at Startup in the New Report Wizard or 

deselecting Show Welcome Wizard under Tools, Options, General tab. 

 

Success 

You have successfully completed this task when the Desktop Intelligence application opens. 
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Practice 

Log on to Desktop Intelligence using this information: 

1) Access the URL given to you by the instructor. 

2) In the InfoView Logon window, type or select the logon information given to you by 

the instructor. 

3) Click Log On. 

4) Click Cancel to close the New Report Wizard. 

 

Summary 

In this topic, you learned how to log on to Desktop Intelligence. 
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Desktop Intelligence Layout 

Overview 

In this topic, you learn the basic layout of Desktop Intelligence. 

Relevance 

By learning the layout of Desktop Intelligence, you can create, modify, and locate ad hoc 

reports more quickly and efficiently. 

Workspace 

The Desktop Intelligence workspace has four main sections: 

 Menu bar 

 Toolbars 

 Report Manager window 

o The Data tab displays the list of objects in a report and allows you to manage 

variables and formulas  

o The Map tab helps you to navigate in a report quickly and easily by clicking the item 

you want to display 

 Report window 
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These images show examples of a report open in the Report window, with basic workspace 

components labeled, as well as the Map tab for the report: 

Example of Report Open in Workspace 

 

 
 

 



Ohio MITS – Intermediate BIAR Participant Guide September 8, 2010 

17 

 

© 2010  
Hewlett-Packard  

Development Company, LP  

 

Example of Map Tab 

 

 
 

 

 
  

To see all of the toolbars available for display, select Toolbars in the 

View menu; then choose the toolbars you want. 

 

 
   

Rest your mouse pointer over the toolbar buttons to see screen tips for 

each button. 
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Query Panel 

The Query panel displays the contents of the Desktop Intelligence universe you selected for 

the report and lets you choose what data you want to display. 

There are four main sections: 

 Query toolbar: Contains buttons that help you to create reports more easily 

 Classes and Objects pane: Displays objects divided into classes (groups) that you use 

to create a report 

 Result Objects pane: Contains objects you have chosen to display as columns in your 

report 

 Conditions pane: Shows conditions you have established to narrow your query results 

 

These images show examples of the Query panel, with basic components labeled: 

 

 
 

 

1) Classes and Objects radio button: Selected by default and shows the Classes and 

Objects pane 

2) Filters radio button: Displays the universe's Predefined Conditions pane that contains 

filters created by the administrator to save you time when using the Conditions pane 

3) Search field: Allows you to search for objects by name instead of having to look for 

objects by scrolling through the Classes and Objects or Predefined Conditions pane 

4) Options: Displays the Query Options window, which gives you further options for 

defining a query, such as limiting the number of rows in the results 

5) Save and Close: Lets you save and close the Query panel without running the query; 

you can return later to run it 
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6) View: Displays the raw data retrieved by the query in the Data Manager; from there, 

you can edit, accept, or cancel the query 

7) Run: Connects the query to the database and displays the report in the Report window 

8) Cancel: Lets you cancel the query without saving your changes 
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Query Panel Conditions Pane 

In the Conditions pane, you can add conditions to narrow your query results. You can use 

predefined conditions or create your own. 

These images show examples of how to add conditions in the Conditions pane: 

Adding a Predefined Condition 
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Creating a Condition 
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See Appendix B for a list of common BusinessObjects operators and 

examples. 

 

Slice and Dice Panel 

The Slice and Dice panel gives you an interface to help you reorganize data in a report. For 

example, you can sort data or move columns to rows to create a crosstab. 

You can also use the Slice and Dice panel to perform other functions, such as adding, 

editing, and deleting section breaks, filters, and calculations. 

This image shows an example of the Slice and Dice panel, with basic components labeled: 
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Check Your Understanding 

This activity contains questions to assess your understanding of key concepts in this topic. 

Review the topic if your score is below your standards. 

 

In which pane do you place objects that you want to have as columns in 

your report? 

A. Classes and Objects 

B. Conditions 

C. Result Objects 

D. Report 

 

In which of these panes can you place objects to narrow your data 

results? 

A. Data 

B. Conditions 

C. Map 

D. Result Objects 

Summary 

In this topic, you learned the basic layout of Desktop Intelligence. 
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Creating an Ad Hoc Report 

Overview 

In this topic, you learn how to create an ad hoc report using the New Report Wizard. 

You are going to create two reports—a basic report using the Provider universe, and a more 

detailed report using the Claims Analysis universe. 

Who 

TBD 

When 

You can create an ad hoc report at any time; however, you can only use the New Report 

Wizard to construct the first query in a document. When you want additional queries, 

you must use the New Document option. 

Relevance 

Creating ad hoc reports lets you tailor reports to meet the specific needs of your job. You 

can incorporate a wide variety of data-analysis functions in addition to the standard reports 

in InfoView. 

Guidelines 

You can create an ad hoc report with or without using the New Report Wizard. 

When you use the New Report Wizard, you make selections in the wizard to create a new 

document and table block. You can only use the wizard to construct the first query in a 

document. 

When you create a report without using the New Report Wizard, you use the New 

Document option. With this option, you create a blank document and then insert a table, 

crosstab, or chart. 

For your convenience and future reference, these are the steps for using the New 

Document option: 

1) Select Options in the Tools menu. 

2) Click the New Document tab. 

3) Select Systematically Create a Blank Document. 

4) Click OK. 

5) Click New on the Standard toolbar. 

6) Select Table, Crosstab, or Chart in the Insert menu, depending on the type of report 

block you want. 

7) Move your mouse pointer onto the blank report area. 

8) Click where you want the top-left corner of the report block to display, and release the 

mouse button. 

9) Click Begin to proceed with the wizard. 
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Note: The title of the first page of the wizard reflects the type of report block you chose in 

Step 6: Insert a New Table, Insert a New Crosstab, or Insert a New Chart. 

No matter what your starting point is for creating a report, you use the Query panel to add 

and organize objects, and apply query conditions. This is where you choose what data you 

want to have in your report. 

In the Query panel, make sure the first three buttons are selected on the toolbar: 

 Show/hide all classes: Displays the Classes and Objects pane 

 Show/hide help on selection item: Displays descriptions in the Information pane for 

objects you select in the Classes and Objects pane; this helps you to choose the 

appropriate objects for your reports 

 Wrap Result Objects: Wraps objects in the Result Objects pane so you do not have to 

scroll to see them 

How To 

Follow these steps from the main Desktop Intelligence window to create an ad hoc report 

using the New Report Wizard: 

 

Step Action 

1 Click New on the Standard toolbar. 

2 Select Generate a standard report. 

3 Click Begin. 

4 Specify the desired data access by following these steps: 

  

TO use: THEN: 

A universe 

a. Select Universe. 

b. Click Next. 

c. Select the desired universe. 

d. Click Finish. 

e. Proceed with Step 5. 

An Excel, dBase, or 

ASCII file 

a. Select Others. 

b. Select the desired option from the Others drop-
down list. 

c. Follow the desired prompts until the wizard 
finishes. 

d. Proceed with Step 10. 
 

5 Expand the desired class(es). 

6 Drag the desired objects to the Result Objects pane.  

Note: You can also double-click an object to add it to the Result Objects pane. 
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Step Action 

With this method, the object automatically displays at the end of the query. 

7 Drag objects and filters as desired to the Conditions pane to narrow your results. 

8 Click Run. 

9 If the prompts window displays, respond to the prompts and click OK.  

10 After the report displays, select Save As in the File menu. 

11 Name the file and save it to the desired folder on your computer. 

Note: userDocs is the default folder. 

 

 
  

You can remove an object two different ways--by dragging or right-

clicking. 

Either drag the object from the Result Objects pane or Conditions pane, 

as applicable, to the Classes and Objects pane OR right-click the object 

and choose Remove or Delete. 

Note: Remove displays when you right-click an object in the Result 

Objects pane and Delete displays when you right-click an object in the 

Conditions pane. 

 

 
  

To close a report, select Close in the File menu. 

 

Success 

You have successfully completed this task when you have created an ad hoc report using 

the New Report Wizard. 

Practice 1 

Create an ad hoc report using the Provider universe that shows a list of rural health clinics 

by county. 

Wizard 

1) Click New on the Standard toolbar. 

2) Select Generate a standard report. 

3) Click Begin. 

4) Select Universe. 

5) Click Next. 

6) Select Provider in the Available Universes list. 

7) Click Finish. 
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Classes and Objects/Result Objects Pane 

8) Expand Base Information. 

9) Add this object: 

o Provider Medicaid ID and Name 

10) Expand Address. 

11) Add this object: 

o County Code & Desc 

 

Classes and Objects/Conditions Pane 

12) Scroll down and expand Type Information. 

13) Add this condition: 

o Provider Type Code Equal to Prompt (‘Enter a Provider Type Code’) 

14) Compare your Query panel with this image: 

 

 
 

 

15) Click Run. 

 

Prompts Window 

16) Click Values and select 05 for the Enter a Provider Type Code field. 

17) Click OK to close the List of Values window. 

18) Click OK to close the prompts window. 

 

Report Window 

19) After the report displays, compare your results with the image at the end of this 

exercise. 
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20) Select Save As in the File menu. 

21) Name the report ―Ad Hoc 1‖ and save the file to the userDocs folder on your 

computer. 

22) Close the report. 

 

 

 
 

Practice 2 

Create an ad hoc report using the Claims Analysis universe that shows basic claim 

information for paid, Fee For Service (FFS), inpatient claims for the first quarter of 2009. 

Note: You are going to use this report as a base for the next topic. 

Wizard 

1) Click New on the Standard toolbar. 

2) Select Generate a standard report. 

3) Click Begin. 

4) Select Universe. 

5) Click Next. 

6) Select Claims Analysis in the Available Universes list. 

7) Click Finish.  

 

Classes and Objects/Result Objects Pane 

8) Expand Detailed Claim Information. 

9) Add this object: 

o ICN 

10) Scroll down and expand Provider Specific Information and then expand Billing 

Provider. 

11) Add this object:  

o Billing Provider Medicaid ID & Name 

12) Scroll down and expand Recipient Specific Information. 

13) Add these objects: 

o Recipient ID 

o Recipient Full Name 

o Recipient Age 

14) Scroll up and expand Claim Dates. 

15) Add these objects: 
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o From Date of Service 

o To Date of Service 

o Payment Date 

16) Scroll down and expand Diagnosis Code Information. 

17) Add this object:  

o Primary Diagnosis Code & Desc 

18) Scroll down and expand Header Paid Claims ONLY Information and then expand 

ICD-9 Procedure Code Info. 

19) Add this object: 

o ICD-9 Procedure Code 1 & Desc 

20) Scroll up and expand Claim Amounts and Counts and then expand Amounts. 

21) Add these objects: 

o Billed Amount 

o Allowed Amount 

o Reimbursed Amount 

 

Classes and Objects/Conditions Pane 

22) Add this condition: 

o Allowed Amount Greater than 100 

23) Scroll down and expand General Claim Information. 

24) Add this condition to the Conditions pane:  

o Claim Type Code Equal to I 

25) Select the Filters radio button. 

26) Expand Detailed Claim Information and then expand Claim Indicators. 

27) Add these filters: 

o Fee for Service Only 

o Claim Header Status – Paid 

o Latest Claims Only 

28) Expand Claim Dates. 

29) Add this filter:  

o Payment Date Range 

30) Scroll down and expand Provider Specific Information and then expand Billing 

Provider. 

31) Add this filter: 

o Billing Provider Medicaid ID – ALL – LIST 
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32) Compare your Query panel with this image: 

 

 
 

 

33) Click Run. 

 

Prompts Window 

34) Type this information in the fields: 

o Billing Provider Medicaid ID or % for ALL: 2354945 

o Payment Date Begin (MM/DD/YYYY): 01/01/2009 

o Payment Date End (MM/DD/YYYY): 03/31/2009 

35) Click OK. 

 

Report Window 

36) After the report displays, compare your results at a high level with the image at the end 

of this exercise. 

37) Select Save As in the File menu. 

38) Name the report "Ad Hoc 2" and save the file to the userDocs folder on your 

computer. 
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39) Keep the report open for the next topic. 

 

 
 

Summary 

In this topic, you learned how to create an ad hoc report using the New Report Wizard. 
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Formatting a Report 

Overview 

In this topic, you learn how to format a report by using a variety of formatting techniques. 

Many formatting options are available in Desktop Intelligence. In this training, you are going 

to use these formatting techniques: 

 Edit, move, and resize a report title 

 Change font style, size, and color 

 Wrap and align text 

 Modify a numeric style 

 Resize a row and column 

 

Who 

TBD 

When 

You can format a report any time after the report is open in the Report window; however, it 

is often helpful to format a report after you have finalized the data layout. 

Relevance 

Formatting a report can make your data more readable and provide a polished look. This is 

helpful when you analyze data and share reports with other users.  

Requirements 

To complete this topic, you must be familiar with these Windows formatting techniques: 

 Using the Shift key to select multiple items next to each other 

 Using the Ctrl key to select noncontiguous items 

Guidelines 

You can use the menu bar, right-click option, or Formatting toolbar to apply formatting to a 

report. 

In this training, you are going to use the Formatting toolbar and right-click option; however, 

feel free to experiment with menu formatting options as well. 

Use the Shift or Ctrl key to select more than one cell at a time. 
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How To 

Follow these steps from the Report window to format a report: 

 

Step Action 

1 Display the desired report. 

2 Apply the desired formatting by following these steps: 

  

TO: THEN: 

Edit the report title 
a. Double-click the title cell. 

b. Type a new title. 

c. Click anywhere outside the cell to stop edit mode. 

Move and resize the 

report title 

a. Select the title cell. 

b. Drag and resize the title cell so the text is 
centered above the width of your report. 

Change font style, size, 

and color 

a. Select the desired cell(s). 

b. Click the desired formatting button(s) on the 
Formatting toolbar. 

Wrap and align text 

a. Right-click the desired cell(s) and select Format 
Cell from the list. 

b. Click the Alignment tab. 

c. Select Wrap Text in the Settings section. 

d. Select the desired options in the Horizontal and 
Vertical sections. 

e. Click OK. 

Modify a numeric style 

a. Right-click anywhere below the header in the 
column that contains the desired measure object. 

b. Select Format Cell. 

c. Click the Number tab. 

d. Select the desired category and format. 

e. Click OK. 

Resize a column or row 

a. Rest your mouse pointer between the column or 
row you want to resize and the column/row next 
to it, so the pointer becomes a double-headed 
arrow. 

b. Either drag or double-click to resize the 
column/row. 

Note: When you double-click, the column to the 

left of the mouse pointer, or the row above the 

mouse pointer, automatically resizes to match 

the width of the widest text in the column/row. 
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Success 

You have successfully completed this task when you have used these formatting techniques: 

 Edit, move, and resize a report title 

 Change font style, size, and color 

 Wrap and align text 

 Modify a numeric style 

 Resize a row and column 

 

Practice 

Format a report using this information: 

Edit, Move, and Resize Report Title 

1) With the Ad Hoc 2 report open from the previous topic, double-click the title cell. 

2) Type a title of your choice. 

3) Click anywhere outside the cell. 

4) Select the title cell. 

5) Drag and resize the cell so the text is centered above the width of your report. 

 

Change Font Style, Size, and Color 

6)  Use the Shift key to select all of the column headings. 

.  

7) Click the desired formatting button(s) on the Formatting toolbar. 

8) Click anywhere outside the cells to see the changes. 

 

Wrap Headings 

9) Use the Shift key to select all of the column headings. 

10) Right-click one of the headings and select Format Cell from the list. 

11) Click the Alignment tab. 

12) Select Wrap Text in the Settings section. 

13) Select Top in the Vertical section. 

14) Click OK. 

 

Align Text 

15)  Use the Shift key to select all of the column headings. 

16) Click an alignment button of your choice on the Formatting toolbar. 

17) Click anywhere outside the cells to see the alignment change. 

 

Change Number Format 

18) Use the Shift key to select all of the measure columns. 

19) Right-click one of the columns below the header and select Format Cell from the list. 

20) Click the Number tab. 

21) Select a category and format of your choice. 

22) Click OK. 
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Resize Heading Row and Columns 

23) Rest your mouse pointer between the heading row and first data row. 

24) Double-click to resize the heading row. 

25) Rest your mouse pointer between the Billing Provider Medicaid ID and Name and 

Recipient ID columns. 

26) Drag to resize the Billing Provider Medicaid ID and Name column. 

27) Resize other columns as desired. 

28) Save the changes and keep the report open for the next topic. 

 

Summary 

In this topic, you learned how to format a report using a variety of formatting techniques. 
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Sorting Data 

Overview 

In this topic, you learn how to sort data in a report. 

You can sort data in ascending, descending, or custom order. By default, rows are sorted in 

ascending order. A custom sort lets you reorder data in a non-alphabetical fashion, such as 

sorting the months of the year in chronological order. 

Who 

TBD 

When 

It is helpful to sort data when you want to locate information in a report more easily or 

when a hierarchical structure will help you to analyze data. 

Relevance 

Sorting data allows you to locate information in a report more quickly, and can help you to 

analyze data more efficiently by viewing results in a hierarchical fashion. 

Guidelines 

There are several ways to sort data in a report. In this training, you learn how to sort data 

using the Report toolbar and Slice and Dice panel. 

When you use the Slice and Dice panel, you can see the order of the sorts from the number 

on the right side of the Sort icon in the block structure. This shows you what column you 

sorted first, second, third, and so on. 

Click the drop-down arrow next to the Insert Sort button to access these options: 

 Apply Ascending Sort 

 Apply Descending Sort 

 Custom Sort 

 

 

 
 

 

 
   

Although it may seem strange, you click the Insert Sort button to both 

add and remove sorts. 
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How To 

Follow these steps from the Report window to sort data: 

 

Step Action 

1 Display the desired report. 

2 Specify the desired sort options using the Report toolbar by following these steps: 

  

TO: THEN: 

Apply a descending sort 
a. Click anywhere below the header in the column 

you want to sort. 

b. Click Apply Descending Sort. 

Apply an ascending sort 
a. Click anywhere below the header in the column 

you want to sort. 

b. Click Apply Ascending Sort. 

Remove a sort 

a. Click anywhere below the header in the column 
for which you want to remove a sort. 

b. Click Insert Sort. 

Note: The Insert Sort button changes from 

being active to inactive. 

Apply a custom sort 

a. Click anywhere below the header in the column 
you want to sort. 

b. Click Custom Sort. 

c. Either drag and drop values, use the Move Up 
and Move Down buttons, or select a value in the 
Sort Option list as desired. 

d. Click OK. 
 

3 Specify the desired sort options using the Slice and Dice panel by following these 

steps: 

a. Click anywhere below the header in the column you want to sort. 

b. Click Slice and Dice on the Standard toolbar. 

c. Click Apply Sort. 

d. If desired, double-click the Sort icon to change the sort type. 

Note: The Sort icon displays A Z for ascending and Z A for descending. Double-

click the Sort icon to toggle from ascending to descending. 

e. To sort additional objects, click each object as desired and then click Apply 

Sort. 

f. Click Apply. 

g. Close the Slice and Dice panel. 
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The Sorts window displays all of the objects to which a sort has been 

applied. You can change the order of the sorts by moving them up or 

down the list to place them in any order. You can also add, remove, and 

invert sorts in the window. 

Sometimes it is difficult to remove multiple sorts using only the Report 

toolbar because you may need to remove the sorts in a specific order. As 

an alternative, you can use the Sorts window. 

To open the Sorts window, click anywhere in the table block and select 

Sorts in the Format menu. 

 

Success 

You have successfully completed this task when you have applied sorts as desired. 

Practice 

Sort data in a report using this information: 

1) With the Ad Hoc 2 report open from the previous topic, click anywhere below the 

header in the Billed Amount column. 

2) Click Apply Ascending Sort. 

3) To remove the sort, click Insert Sort. 

4) To apply a custom sort: 

a) Click anywhere below the header in the Primary Diagnosis Code & Desc column. 

b) Click Custom Sort. 

c) Move code 1231 to the top of the list. 

d) Click OK. 

 

5) To remove the sort, click Insert Sort. 

6) To apply sorts using the Slice and Dice panel, follow these steps: 

a) Click anywhere below the header in the Recipient Age column. 

b) Click Slice and Dice on the Standard toolbar. 

c) Click Apply Sort. 

 

 

d) Double-click the Sort icon to change the sort to descending order. 

 

 

e) To apply a second sort, select Billed Amount. 

f) Click Apply Sort. 
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g) Click Apply. 

h) Close the Slice and Dice panel. 

 

7) Save the changes and close the report. 

 

Summary 

In this topic, you learned how to sort data in a report. 
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Applying a Section Break 

Overview 

In this topic, you learn how to group data in a report by applying a section break. A section 

break eliminates repeated values for a column by organizing data into subgroups based on 

the value you select. 

For example, you could group a report by the Claim Type Code & Description object. 

There are several ways to apply a section break. In this training, you learn to apply the 

method that allows the grouped value to display as a header outside of the report block, 

which makes navigating to the sections quick and easy. 

Who 

TBD 

When 

It is helpful to apply a section break to a report when turning repeated values into 

subgroups will help you to analyze data for your job. 

Relevance 

Applying a section break helps you to view, locate, and analyze data more efficiently by 

organizing common values into subgroups. You can also add a total for each subgroup 

quickly and easily to enhance your analysis further. 

Requirements 

To apply a section break, a report must have repeated values for a dimension or detail 

object in at least one column. You cannot apply a section break based on a measure object. 

How To 

Follow these steps from the Report window to apply a section break: 

 

Step Action 

1 Click anywhere below the header in the column that contains repeated values for 

which you want to apply a section break. 

2 Click Set as Master on the Report toolbar. 
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You can apply more than one section break to a report to add further 

subgroups for analyzing data. 

 

 
  

You can navigate to any group in a report by clicking the Map tab in the 

Report Manager and then selecting the group you want. 

 

Success 

You have successfully completed this task when a section break displays in a report. 

Practice 

Apply two section breaks using this information: 

1) Open the Ad Hoc Summary report from the userDocs folder. 

2) Click anywhere below the header in the FFS/Enc Indicator column. 

3) Click Set as Master on the Report toolbar. 

4) Click anywhere below the header in the Claim Type Code & Desc column. 

5) Click Set as Master on the Report toolbar. 

6) Compare your results at a high level with the image at the end of this exercise. 

7) Save the report as ―Ad Hoc Summary Section Breaks‖ and close the report. 

 

 
 

Summary 

In this topic, you learned how to apply a section break. 
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Outlining Data 

Overview 

In this topic, you learn how to outline data in a report. Outlining data lets you hide the 

details of a report temporarily so you only see the group headers and summary figures. This 

is especially useful for large reports that contain a lot of information. This way, you can 

scroll through a report more easily. 

When you find a group you want to view in more detail, you can expand the outline view to 

see the details for that particular group. 

 

 
  

Hiding the details of a report is also known as folding the data. 

 

Who 

TBD 

When 

You can outline data in a report when the report contains at least one section break. 

Outlining data is helpful when you want to hide and expand details to make analyzing data 

easier. 

Relevance 

An outline view of a report gives you the flexibility to show only the headings of groups or 

expand one or more groups to view the details. This makes it easier to locate and analyze 

data, thus improving time and efficiency. 

Requirements 

To outline data, a report must have at least one section break. 

You must be familiar with section breaks before completing this topic. 
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How To 

Follow these steps from the Report window to outline data: 

 

Step Action 

1 Display the desired report. 

2 Select Outline in the View menu.  

Note: An outline view displays with twisties (arrows) next to each header, and a 

number at the bottom of the outline for each section in the report. For example, if 

there is one section, a 1 displays; if there are two sections, a 2 displays. The 

numbers and twisties act as toggle buttons to hide and view details. 

3 Click the desired number(s) to hide/view the details of the corresponding 

section(s). 

4 Click the twistie for the desired heading(s) to hide/view details for the group(s). 

 

Success 

You have successfully completed this task when you have outlined data in a report. 

Practice 

Outline data using this information: 

1) Open the Create Outline report from the userDocs folder. 

2) Select Outline in the View menu. 

3) Experiment with the outline feature by clicking 2 and then clicking 1. 

4) Compare your results at a high level with the images at the end of this exercise. 

5) Save the report as ―Outline‖ and close the file. 
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Outline Expanded 
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Outline Collapsed 

 

 
 

Summary 

In this topic, you learned how to outline data. 
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Creating and Modifying a Chart 

Overview 

In this topic, you learn how to create and modify a chart based on an existing table block. 

You can convert a table or crosstab to a variety of chart types to display your data 

graphically, and can apply many formatting options. 

Who 

TBD 

When 

You can create a chart when the report contains at least one measure object. It is helpful to 

create a chart when you want a visual representation of the data to assist in your data 

analysis. 

Relevance 

Creating a chart lets you analyze data quickly at a high level through a visual representation 

of the information. This can help you to notice problem areas and trends more easily for 

further study. 

Requirements 

To create a chart, a report must contain at least one measure object. 

How To 

Follow these steps from the Report window to create and modify a chart: 

 

Step Action 

1 Display the desired report. 

2 Right-click anywhere in the table block and select Turn to Chart. 

3 Select the desired chart type and style. 

Note: The chart type and style that lend themselves the best to the block 

structure are selected by default. 

4 Click OK. 

5 Modify the chart as desired by following these steps: 
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Step Action 

TO: THEN: 

Resize the chart 

a. Select the chart image. 

b. Drag the sizing handles as desired. 

Note: Make sure the whole chart image is 

selected and not just pieces of the chart or the 

surrounding area. The sizing handles should 

surround the whole chart image. When you 

resize the chart, the rest of the chart objects 

should automatically resize at the same time in 

proportion. 

Format the chart 

a. Right-click the desired area of the chart. 

b. Select the desired formatting option. 

Note: The formatting options are context-

sensitive, so each area of the chart you right-

click provides a different menu. 

c. Modify the formatting as desired. 

d. Click OK. 

e. Repeat Steps a through d as desired. 
 

 

Success 

You have successfully completed this task when you have created a chart and modified it as 

desired. 

Practice 

Create and modify a chart using this information: 

1) Open the Create a Chart report from the userDocs folder. 

2) Right-click anywhere in the table block and select Turn to Chart. 

3) Select Column in the Chart Types section. 

4) Select the second chart style from the left in the Styles for Selected Chart Type 

section. 

5) Resize the chart to approximately six inches wide by five inches tall. 

6) Add a title to the chart by following these steps: 

a) Right-click a blank area of the chart and select Format Chart from the list. 

b) In the Name field of the General tab, type a title of your choice. 

c) Select Title in the Show section. 

d) Click OK. 

 

7) Change the color of the data series by following these steps: 

a) Right-click the data series and select Format Data Series from the list. 

b) In the Fill section, change the Foreground Color to a color of your choice. 

c) Click OK. 
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8) Compare your results at a high level with the image at the end of this exercise. 

9) Save the report as ―Chart‖ and close the file. 

 

 
 

Summary 

In this topic, you learned how to create and modify a chart. 
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Creating a Crosstab 

Overview 

In this topic, you learn how to create a crosstab based on an existing table block. A crosstab 

looks similar to an Excel spreadsheet with data presented in cells and cross-referenced by 

headings on the vertical and horizontal axes. 

For example, this crosstab shows billing providers on the left, the payment date at the top, 

and the reimbursed amount at the intersection of those axes: 

 

 
 

Who 

TBD 

When 

It is helpful to create a crosstab when turning repeated values into a cross-referenced 

layout will help you to analyze data for your job. 

Relevance 

When a report contains repeated column values, you can make the data easier to read and 

analyze by changing the format to a crosstab to eliminate the repetition. 

Requirements 

To create a crosstab, a report must have repeated values in at least one column. 
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How To 

Follow these steps from the Report window to create a crosstab: 

 

Step Action 

1 Display the desired report. 

2 Click anywhere in the table block. 

3 Select Table in the Format menu. 

4 Click the Pivot tab. 

5 Drag the desired objects into the appropriate folders in the Used Variables 

section. 

6 Click OK. 

7 If desired, apply one or more section breaks to enhance the crosstab. 

Success 

You have successfully completed this task when you have created a crosstab. 

Practice 

Create a crosstab using this information: 

1) Open the Create a Crosstab report from the userDocs folder. 

2) Click anywhere in the table block. 

3) Select Table in the Format menu. 

4) Click the Pivot tab. 

5) Update the Used Variables section by following these steps: 

a) Drag the Billing Provider Medicaid ID & Name object to the Columns folder. 

b) Drag the Payment Date object to the Rows folder. 

c) Click OK. 

 

6) Follow these steps to create a section break by payment month: 

a) Click anywhere below the header in the Payment Month column. 

b) Click Set as Master on the Report toolbar. 

 

7) Follow these steps to change the formatting of the Payment Month object: 

a) Right-click the Payment Month object and select Format Cell. 

b) Click the Number tab. 

c) Select Number in the Category section. 

d) Select 0 (zero) in the Format section. 

e) Click OK. 

 

8) Compare your results at a high level with the image at the end of this exercise. 
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9) Save the report as ―Crosstab‖ and close the file. 

 

 
 

Summary 

In this topic, you learned how to create a crosstab. 
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Adding a Rank 

Overview 

In this topic, you learn how to add a rank. A rank lets you view the largest or smallest 

numbers in a report, and hides the rest of the data. 

For example, you could apply a rank to show the top five billing providers for anesthesiology 

based on the total claim reimbursed amount for a specific year. 

 

 
  

For your convenience and future reference, the How To table also 

provides information on how to modify and remove a rank. 

Who 

TBD 

When 

It is helpful to add a rank to a report when you want to view top or bottom values based on 

at least one measure to aid in data analysis. 

Relevance 

Adding a rank lets you show only the extreme ranges of your data and hides the rest. This 

can help you to research problem areas and trends more easily by having a good starting 

point from which to base further analysis. 

Requirements 

To add a rank, a report must have at least one measure object on which to base the rank. 

Guidelines 

A rank lets you view the top or bottom three or more results for a particular dimension 

based on a specific measure. It is good practice to begin in the column that contains the 

dimension you want to rank. 
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How To 

Follow these steps from the Report window to add, modify, and remove a rank: 

 

Step Action 

1 Display the desired report. 

2 Click anywhere below the header in the column for which you want to apply a 

rank. 

3 Click Apply Ranking on the Report toolbar. 

4 Select the Top or Bottom checkbox as desired. 

5 Change the number as desired. 

6 Change the Based on measure as desired. 

7 Click OK. 

8 Modify and remove a rank as desired by following these steps: 

  

TO: THEN: 

Modify a rank 

a. Click Slice and Dice on the Standard toolbar. 

b. Double-click the Apply Ranking icon next to the 
desired object. 

c. Modify the information as desired. 

d. Click OK. 

e. Click Apply. 

f. Close the Slice and Dice panel. 

Remove a rank 

a. Click anywhere below the header in the column 
for which you want to remove a rank, 

b. Click Apply Ranking on the Report toolbar. 

Note: The Apply Ranking button changes from 

being active to inactive. 
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Success 

You have successfully completed this task when you have added, modified, and removed a 

rank from a report. 

Practice 

Add a rank that shows the top billing providers in Adams county, based on the reimbursed 

amount, for the last ten days in January 2009. 

1) Open the Add a Rank report from the userDocs folder. 

2) Click anywhere below the header in the Billing Provider column. 

3) Click Apply Ranking on the Report toolbar. 

4) Select the Top checkbox. 

5) Change the Top number to a number of your choice. 

6) Click OK. 

7) Compare your results at a high level with the image at the end of this exercise. 

8) Save the report as ―Top Rank‖ and close the file. 

 

 
 

Summary 

In this topic, you learned how to add a rank. 
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Adding an Alerter 

Overview 

In this topic, you learn how to add an alerter. An alerter lets you highlight data in a report 

through special formatting to draw attention to data that fits certain conditions. 

For example, you could add an alerter to shade any monetary amounts over $50,000 

received by a provider for a specific service. 

 

 
  

For your convenience and future reference, the How To table also 

provides information on how to modify and remove an alerter. 

Who 

TBD 

When 

It is helpful to add an alerter to a report when you want to monitor and explore specific 

conditions based on at least one measure. This can save you time in reviewing data and 

performing data analysis. 

 

 
  

Importing standard reports from InfoView and adding alerters to the 

reports is especially helpful for information you want to monitor 

regularly. 

Relevance 

Adding an alerter draws attention to data that meets certain conditions in your report. This 

helps to show trends and exceptions to aid you in data analysis. 

Requirements 

To add an alerter, a report must have at least one measure object on which to base the 

alerter. 

You must be familiar with basic operator concepts and conditions to create an alerter. For 

example, it is important to understand the meaning of this statement: 

"If the Total Reimbursed Amount is greater than $100,000 and less than $150,000 for a 

provider, then apply light-gray shading with dark-blue text to the Provider ID cell." 

For more information about operators, see Appendix B. 
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Guidelines 

To apply an alerter, it is good practice to begin in the column that contains the dimension 

you want to use for the alerter. 

There are four main steps to creating an alerter: 

 Select the data you want to use 

 Name/describe the alerter 

 Choose the range of values on which to base the alerter 

 Set up how you want the alerter to display in the cells—for example, light-gray shading 

with dark-blue text 

How To 

Follow these steps from the Report window to add, modify, and remove an alerter: 

 

Step Action 

1 Display the desired report. 

2 Click anywhere below the header in the column for which you want to apply an 

alerter. 

3 Click Alerters on the Report toolbar. 

4 Click Add. 

5 Type the desired name in the Name field. 

6 Type the desired description in the Description field. 

7 Click the Conditions tab. 

8 Verify that the Variable to Compare field contains the desired variable; 

otherwise, select the desired variable from the list. 

9 Select the desired operator(s), value(s), and result. 

10 Click OK to close the Edit Alerters window. 

11 Click OK to close the Alerters window. 
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Step Action 

12 Modify and remove an alerter as desired by following these steps: 

  

TO: THEN: 

Modify an alerter 

a. Click anywhere in the table block. 

b. Click Alerters on the Report toolbar. 

c. Select the desired alerter and click Edit. 

d. Modify the information as desired. 

e. Click OK to accept the changes and close the 
Edit Alerters window. 

f. Click OK to close the Alerters window. 

Remove an alerter 

a. Click anywhere in the table block, 

b. Click Alerters on the Report toolbar. 

c. Select the desired alerter and click Remove. 

d. Click OK. 
 

Success 

You have successfully completed this task when you have added, modified, and removed an 

alerter from a report. 

Practice 

Add an alerter using this information: 

1) Open the Ad Hoc 2 report from the userDocs folder. 

2) Click anywhere below the header in the Reimbursed Amount column. 

3) Click Alerters on the Report toolbar. 

4) Click Add. 

5) Type ―Reimbursed Amount Greater Than 12,000‖ in the Name field of the 

Definition tab. 

6) Type ―Highlight reimbursed amounts greater than $12,000‖ in the Description 

field. 

7) Click the Conditions tab. 

8) Select > (greater than) in the Operator 1 drop-down list. 

9) Type 12000.00 in the Value 1 field. 

10) Select None in the Operator 2 drop-down list. 

11) Select Format in the Result drop-down list. 

12) Click the Font tab. 

13) Select the Custom radio button and choose a color. 

14) Click OK to close the Color window. 

15) Click the Shading tab. 

16) In the Background Color section, select the Custom radio button and choose a color. 

17) Click OK to close the Color window. 

18) Click OK to close the Cell Format window. 

19) Click OK to close the Edit Alerters window. 
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20) Click OK to close the Alerters window. 

21) Click anywhere outside the Reimbursed Amount column to see the results. 

22) Compare your results at a high level with the image at the end of this exercise. 

23) Save the report as ―Alerter‖ and keep the file open for the next topic. 

 

 

 
 

Summary 

In this topic, you learned how to add an alerter. 
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Using Drill-Down Mode 

Overview 

In this topic, you learn how to use drill-down mode. Drill-down mode lets you analyze data 

in a report at a more detailed level. You start with a higher-level view and drill down to 

one or more detail-level views. 

For example, you could start with a report that shows the top five billing providers based on 

the Total Claim Paid Amount for a given quarter, and then drill down to more specific 

information, such as the procedure code and description for each claim. 

Who 

TBD 

When 

It is helpful to use drill-down mode when you want to see a high-level view of the data first 

and be able to drill down to more detailed views. This can save you time in reviewing data 

and performing data analysis. 

Relevance 

Using drill-down mode lets you start with higher-level data and progress to more detailed 

views without having to run separate reports. This helps you to analyze data more quickly 

and offers an efficient way to capture your data-analysis process through filters that track 

the various levels of detail as you drill down in a report. 

Requirements 

To use drill-down mode, a report must have at least one object on which to drill. 

Guidelines 

When you use drill-down mode, the detail levels are available based on hierarchies the 

universe designer created when setting up each universe. Therefore, you cannot drill down 

on all objects--only on objects included in the hierarchy structure as being "drillable." 
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How To 

Follow these steps from the Report window to drill down in a report: 

 

Step Action 

1 Display the desired report. 

2 Click anywhere in the table block. 

3 Click Drill on the Standard toolbar.  

Note: Desktop Intelligence inserts a new report tab and displays the same table 

block in drill mode. 

4 Click anywhere in the table block for the new report tab. 

5 Select Scope of Analysis in the Analysis menu.  

Note: The Scope of Analysis window shows all available objects in a hierarchy. 

You can select one or more objects to include in the scope available for drilling. 

You can also select filter objects to limit your results. 

6 Select the desired classes and objects. 

7 Click OK. 

8 Right-click the cell on which you want to drill. 

9 Point to Drill By and select the desired object.  

Note: Desktop Intelligence moves the original column data to the top of the 

Report window and displays the data in a filter drop-down list. The object you 

chose for drilling replaces the former data in the column. 

10 As desired, continue to drill down to the bottom level of data by repeating Steps 8 

and 9.  

Note: When you perform additional drill-downs, a new filter displays each time 

you drill down. 

11 Use the drill filters at the top of the Report window as desired to display the data 

you want to analyze.  

Note: To move the filter data to the table block, scroll to the bottom of the filter 

list and select Move to Block. Desktop Intelligence inserts the data as a new 

column in the report. 

12 To drill back up, follow these steps: 

a. Right-click the cell on which you want to drill up. 

b. Point to Drill Up and select the desired object. 
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Drill Down lets you drill down one level, compared with Drill By in 

which you can choose any available level from the list. 

Drill Through is similar to the Scope of Analysis window. The main 

differences are that with Drill Through, you can only select one object at 

a time and cannot apply filter objects. 

Success 

You have successfully completed this task when you have drilled down in a report. 

Practice 

Drill down in a report to see recipients’ Social Security Numbers using this information: 

1) With the Alerter report open from the previous topic, click anywhere in the table block. 

2) Click Drill on the Standard toolbar. 

3) Click anywhere in the table block for the new report tab. 

4) Select Scope of Analysis in the Analysis menu. 

5) Scroll down to Recipient Specific Information. 

6) Select Recipient SSN. 

7) Click OK. 

 

Prompts Window 

8) Type this information in the fields: 

o Billing Provider Medicaid ID or % for ALL: 2354945 

o Payment Date Begin (MM/DD/YYYY): 01/01/2009 

o Payment Date End (MM/DD/YYYY): 03/31/2009 

9) Click OK. 

 

Report Window 

10) Right-click the first data row in the Billing Provider Medicaid ID & Name column. 

11) Point to Drill By and select Recipient SSN. 

12) Compare your results at a high level with the image at the end this exercise. 

13) Save the report as ―Drill Down‖ and close the file. 
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Summary 

In this topic, you learned how to use drill-down mode. 
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Inserting Calculations 

Overview 

In this topic, you learn how to insert these calculations in a report: 

 Sum 

 Count 

 Average 

 Subtraction 

 Running Total 

 

 
  

These calculations are also known as "functions." A function performs a 

specific operation on one or more values you specify, such as counting 

how many providers are listed in a report. 

Who 

TBD 

When 

It is helpful to insert calculations when you want to perform additional analysis using 

formulas. The types of calculations you can use are based on the kinds of objects in each 

report. 

For example, you can apply the Insert Sum function to total measure objects and the Insert 

Count function to total dimension objects. 

Requirements 

When inserting calculations, it is important to be familiar with these types of objects 

described in the Getting Started topic: 

 Measure 

 Dimension 

 Detail 

 

The kind of calculation you can insert depends on the type of object you are using in the 

calculation. For example, the Insert Sum function only works with measure objects, while 

the Insert Count function can be used for dimension, detail, or measure objects. 
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Relevance 

Inserting calculations lets you analyze data beyond using only the built-in objects in each 

universe. You can obtain totals, averages, and other results quickly and easily. 

Guidelines 

You can add subtotals to reports with sections breaks through the Insert Sum and Insert 

Count functions by following the same steps as you would for a report without section 

breaks. Desktop Intelligence automatically applies the total functions you add to one group 

in a section to all groups in the section. 

How To 

Follow these steps from the Report window to insert calculations: 

 

Step Action 

1 Display the desired report. 

2 Insert the desired calculation(s) by following these steps: 

  

TO insert: THEN: 

A Sum 
a. Click anywhere below the header in the column 

for which you want to insert the sum. 

b. Click Insert Sum on the Report toolbar. 

A Unique Count, not 

including duplicates 

a. Click anywhere below the header in the column 
for which you want to insert the count. 

b. Click Insert Count on the Report toolbar. 

A Complete Count, 

including duplicates 

a. Right-click anywhere below the header in the 
column for which you want to insert the count. 

b. Point to Calculations and select Count All. 

An Average 
a. Right-click anywhere below the header in the 

column for which you want to insert the average. 

b. Point to Calculations and select Average. 
 

3 To prepare for inserting a subtraction, add a column on the far-right by following 

these steps:  

a. Click anywhere below the header in the last column of the report. 

b. Select Column in the Insert menu. 

c. Select Insert a Column to the Right of the Selection. 

d. Click OK. 

e. Double-click the new column header and type a name for the column. 

f. Press Enter on your keyboard. 
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Step Action 

4 Insert a subtraction by following these steps: 

a. Right-click the first empty cell under the header of the blank column and select 

Variables. 

b. Click Add. 

c. Click the Formula tab. 

d. In the Variables section, double-click the first object desired for the 

subtraction calculation. 

e. Press the Minus Sign on your keyboard. 

f. In the Variables section, double-click the second object desired for the 

subtraction calculation. 

g. Click OK to close the Variable Editor window. 

h. Click Insert to close the Variables window and see the formula results in the 

column. 

5 To prepare for inserting a running total, add a column on the far-right by following 

Step 3 above. 

6 Insert a running total by following these steps: 

a. Right-click the first empty cell under the header of the blank column and select 

Variables. 

b. Click Add. 

c. Click the Formula tab. 

d. In the Functions section, expand the Aggregates folder. 

e. Double-click RunningSum. 

f. In the Variables section, double-click the object for which you want to have a 

running total. 

g. Click OK to close the Variable Editor window. 

h. Click Insert to close the Variables window and see the formula results in the 

column. 

 

Success 

You have successfully completed this task when you have inserted these calculations in a 

report: 

 Sum 

 Count 

 Average 

 Subtraction 

 Running total 
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Practice 

Insert calculations using this information: 

1) Open the Insert Calculations report from the userDocs folder. 

 

Sum 

2) Click anywhere below the header in the Reimbursed Amount column. 

3) Click Insert Sum on the Report toolbar. 

 

Count 

4) Click anywhere below the header in the Billing Provider Medicaid ID & Name 

column. 

5) Click Insert Count on the Report toolbar. 

 

Average 

6) Right-click anywhere below the header in the Billed Amount column. 

7) Point to Calculations and select Average from the list. 

 

Subtraction 

8) Click anywhere below the header in the last column of the report. 

9) Select Column in the Insert menu. 

10) Select the Insert a Column to the Right of the Selection radio button. 

11) Click OK.  

12) Double-click the new column header and type this name for the column: ―Allowed 

Minus Billed.‖  

13) Press Enter on your keyboard. 

14) Right-click the first empty cell under the header of the blank column and select 

Variables. 

15) Click Add. 

16) Click the Formula tab. 

17) In the Variables section, double-click Allowed Amount. 

18) Press the Minus Sign on your keyboard. 

19) In the Variables section, double-click Billed Amount. 

20) Click OK to close the Variable Editor window. 

21) Click Insert to close the Variables window and see the formula results in the column. 

 

Running Total 

22) Click anywhere below the header in the last column of the report. 

23) Select Column in the Insert menu. 

24) Select the Insert a Column to the Right of the Selection radio button. 

25) Click OK.  

26) Double-click the new column header and type this name for the column: ―Running 

Total of Reimbursed Amount by Specialty Code.‖ 

27) Press Enter on your keyboard. 
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28) Right-click the first empty cell under the header of the blank column and select 

Variables. 

29) Click Add. 

30) Click the Formula tab. 

31) In the Functions section, expand the Aggregates folder. 

32) Double-click RunningSum. 

33) In the Variables section, double-click Reimbursed Amount. 

34) Click OK to close the Variable Editor window. 

35) Click Insert to close the Variables window and see the formula results in the column. 

36) Compare your results at a high level with the image at the end of this exercise. 

37) Save the report as ―Calculations‖ and close the file. 

 

Summary 

In this topic, you learned how to insert these calculations in a report:  

 Sum 

 Count 

 Average 

 Subtraction 

 Running Total 
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Adding Free-Standing Cells 

Overview 

In this topic, you learn how to add free-standing cells to a report. Free-standing cells are 

not attached to other report elements and can be used in a variety of ways, such as for 

report titles, introductory text for other cells, dates, or to draw attention to specific 

variables. 

Who 

TBD 

When 

It is helpful to add free-standing cells to a report when you want to display information in 

addition to the available elements or draw attention to specific variables. 

Relevance 

Adding free-standing cells to a report lets you display information beyond using only the 

current table block. This gives you increased flexibility to tailor reports to meet your needs. 
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How To 

Follow these steps from the Report window to add free-standing cells to a report: 

 

Step Action 

1 Display the desired report. 

2 Add free-standing cells by following these steps: 

  

TO add: THEN: 

Text 

a. Select Cell in the Insert menu. 

b. Click where you want the cell to be placed. 

c. Type the desired text. 

d. Click anywhere outside the cell. 

e. Format the cell as desired. 

A special field 

a. Point to Special Field in the Insert menu. 

b. Select the desired option. 

c. Click where you want the cell to be placed. 

d. Format the cell as desired. 

An existing variable or 

formula 

a. Expand the desired folder in the Report Manager 
Data tab. 

b. Drag the desired variable or formula onto the 
report and release the mouse button where you 
want to place the cell. 

c. Format the cell as desired. 
 

 

 
  

You can copy and paste free-standing cells among reports. 

 

 
  

Use the Shift or Ctrl key to select more than one cell at once. This 

allows you to copy or format multiple cells at the same time. 

 

Success 

You have successfully completed this task when your report has been enhanced by 

displaying information through free-standing cells. 
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Practice 

Add free-standing cells using this information: 

1) Open the Add Free-Standing Cells report from the userDocs folder. 

 

Text: 

2) Select Cell in the Insert menu. 

3) Click in the upper-left corner of the report to place the cell. 

4) Type this text: "Total Sum of Billed Amount:," including the colon after "Amount." 

5) Click anywhere outside the cell. 

6) Resize the cell as needed and apply formatting to remove the borders. 

 

Variable: 

7) Drag the Sum of Billed Amount object from the Variables folder in the Report 

Manager Data tab to the right of the "Total Sum of Billed Amount:" cell. 

8) Resize the object so all of the numbers show. 

9) Format and align the object as desired. 

 

Special Field/Date and Time: 

10) In the Insert menu, point to Special Field and then point to Date and Time. 

11) Select Last Refresh. 

12) Click in the upper-right corner of the report to place the Last Refresh field. 

13) Add this text to the left of the field: "Last Refresh:," including the colon after "Refresh." 

14) Format and align both cells as desired. 

15) Make sure both cells are deselected before moving to the next step. 

 

Special Field/Query Prompt: 

16) In the Insert menu, point to Special Field and then point to Query Prompt. 

17) Select Payment Date Begin (MM/DD/YYY). 

18) Click OK. 

19) Click in a blank area towards the top-center of the report to place the Query Prompt 

field. 

20) Add this text cell to the left of the field: "Beginning Payment Date:," including the 

colon after "Date." 

21) Format and align both cells as desired. 

22) Make sure both cells are deselected before moving to the next step. 

23) In the Insert menu, point to Special Field and then point to Query Prompt. 

24) Select Payment Date End (MM/DD/YYY). 

25) Click OK. 

26) Click in a blank area towards the top-center of the report to place the Query Prompt 

field. 

27) Add this text cell to the left of the field: "Ending Payment Date:," including the colon 

after "Date." 

28) Format and align both cells as desired. 

29) Compare your results at a high level with the image at the end of this exercise. 
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30) Save the report as ―Free-Standing Cells‖ and close the file. 

 

 

 
 

Summary 

In this topic, you learned how to add free-standing cells to a report. 
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Importing a Report from the Repository 

Overview 

In this topic, you learn how to import a report from the BusinessObjects repository. The 

repository gives you access to the same standard and personal reports you see in InfoView. 

Who 

TBD 

When 

It is helpful to import a report from the BusinessObjects repository when you want to use a 

standard report as a base and add, edit, or remove information instead of creating a brand 

new an ad hoc report. 

Relevance 

Importing and modifying a report from the BusinessObjects repository can save time and 

increase efficiency without having to create a new ad hoc report. This is especially helpful if 

there are complex formulas in the standard report that match what you are seeking or if the 

report's layout is similar to what you need. 

How To 

Follow these steps from the main Desktop Intelligence window to import a report from the 

BusinessObjects repository: 

 

Step Action 

1 Select Import from Repository in the File menu. 

2 Select the desired folder in the Browse Folders pane. 

3 Select the desired report(s).  

Note: Use the Shift key to select reports next to each other and the Ctrl key to 

select noncontiguous reports. 

4 Click Retrieve.  

Note: The report(s) download to the userDocs folder. 

5 Click OK to close the successful-import message. 

6 Click Close. 
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Step Action 

7 Open and modify the report(s) as desired. 

 

Success 

You have successfully completed this task when you have imported a report from the 

BusinessObjects repository. 

Practice 

Import a report from the BusinessObjects repository using this information: 

1) Select Import from Repository in the File menu. 

2) Select a folder of your choice in the Browse Folders pane. 

3) Select a report of your choice. 

4) Click Retrieve. 

5) Click OK to close the successful-import message. 

6) Click Close. 

7) From the userDocs folder, open the report you downloaded. 

8) Close the report. 

Summary 

In this topic, you learned how to import a report from the BusinessObjects repository.  
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Exporting Data 

Overview 

In this topic, you learn how to export data from Desktop Intelligence to another application 

on your computer. 

Who 

TBD 

When 

It is helpful to export data when you want to analyze information using another file format, 

or when you want to share reports with users who do not have access to Desktop 

Intelligence. 

 

 
  

You can export data to these file types: 

 Text Files (*.asc; *.prn; *.txt; *.csv) 

 Microsoft Excel Files (*.xls) 

 dBASE Files (*.dbf) 

 Microsoft Excel 97 Files (*.xls) 

 XML Files (*.xml) 

 

Relevance 

Exporting data allows you to analyze and share information outside of Desktop Intelligence. 

This gives you additional flexibility for your reporting needs. 
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How To 

Follow these steps from the Report window to export data: 

 

Step Action 

1 Create or display the desired report. 

2 Click View Data on the Standard toolbar. 

3 If necessary, select the desired data provider. 

4 Click Export. 

5 Select the desired file format in the Format drop-down list. These are the choices:  

 Text Files (*.asc; *.prn; *.txt; *.csv) 

 Microsoft Excel Files (*.xls) 

 dBASE Files (*.dbf) 

 Microsoft Excel 97 Files (*.xls) 

 XML Files (*.xml) 

6 Click Browse and select the desired location for the exported file. 

7 Click Save. 

8 Click OK. 

9 Click OK when the export completion message displays. 

10 Click OK to close the Data Manager window. 

 

 
  

When you export data to Excel, the size limitation is 65,536 rows. 

 

Success 

You have successfully completed this task when the exported file has been saved to your 

computer. 
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Practice 

Export data to Excel using this information: 

1) Open the Ad Hoc 2 report from the userDocs folder. 

2) Click View Data on the Standard toolbar. 

3) Click Export. 

4) Select Microsoft Excel Files (*.xls) in the Format drop-down list. 

5) Click Browse and select My Documents. 

6) Change the file name to ―Ad Hoc 2 Export.‖ 

7) Click Save. 

8) Click OK. 

9) Click OK when the export completion message displays. 

10) Click OK to close the Data Manager window. 

11) View the Excel workbook and close the file. 

 

Summary 

In this topic, you learned how to export data from Desktop Intelligence to another 

application on your computer. 
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Review 

In this course, you learned how to: 

 

 Log on to Desktop Intelligence 

 Create an ad hoc report 

 Format a report 

 Sort data in a report 

 Apply a section break 

 Outline data 

 Create and modify a chart 

 Create a crosstab 

 Add a rank 

 Add an alerter 

 Use drill-down mode 

 Insert calculations 

 Add free-standing cells 

 Import a report from the repository 

 Export data 
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Appendix A 

Additional and More Detailed Terminology 

This table provides additional and more detailed BusinessObjects terminology than is 

covered in the Getting Started topic: 

Term Description 

Alerter A feature that applies specified formats or contents to cells if the data 

in the cells falls within a given range of values or satisfies set 

conditions. 

Class  A logical grouping of data in a universe, displayed as a folder in the 

Classes and Objects or Predefined Conditions pane. A single class 

folder can contain many objects, as well as other class folders that 

also hold numerous objects. 

Crosstab A table that displays data in columns, rows, and at the intersection 

(crosstab body) of the columns and rows. A crosstab looks similar to 

an Excel spreadsheet. 

Drill Down The process of navigating from less detailed information to more 

detailed data. 

Filter A feature that lets you narrow the data that displays in a report. 

Filters are formulas that consist of three elements: objects, 

operators, and operands. 

Function A pre-defined operation, such as ―sum,‖ ―average,‖ ―maximum,‖ etc. 

Object A universe element that represents a set of data from a relational 

database. Objects are included in a query to retrieve data from the 

database and are grouped into classes. There are dimension, detail, 

and measure objects. 

A dimension object retrieves the data that provides the basis for 

analysis in a report. Dimension objects typically retrieve character-

type data, such as provider names. 

A detail object provides additional information. For example, an 

address is a detail object associated with a provider. Addresses 

provide additional information about providers. 

A measure object retrieves numeric data that is the result of 

calculations on data in the database. 

Operand Identifies the value being compared to an object using a specified 

operator. 

Operator A relational or logical calculation used to determine the relationship 
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Term Description 

between an object and an operand.  

Prompt A sentence or question that asks you to select or enter values to 

narrow your query results. 

Query A request for information that uses a specific set of instructions for 

extracting data from a database in a readable format according to 

criteria you establish. 

You build a query containing objects from a universe and then run 

the query to generate a report. 

Query Result Data returned by a query. 

Refresh An action that updates the data returned by a report’s query. 

Sort A feature you can apply to cause data to display in ascending, 

descending, or custom order. 

Universe A database view comprised of a logical grouping of classes and 

objects that allows you to create queries and retrieve data 

 

Note: The descriptions above are based on information found at 

http://www.businessobjects.com/businessintelligence/glossary.asp and in the 

BusinessObjects Glossary, 2003, (3 May 2008), BusinessObjects S.A., downloaded from 

http://technicalsupport.businessobjects.com/KanisaSupportSite. 
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Appendix B 

BusinessObjects Operators 

This table provides a description of common BusinessObjects operators: 

Name To Obtain Data... Example 

Equal to Equal to a value you specify [Provider ID] Equal to 

00112233445 

Not equal to Not equal to a value you specify [Specialty Code] Not equal to 05 

Greater than Greater than a value you specify [Claim Paid Amount] Greater 

than 500 

Greater than or 

equal to 

Greater than or equal to a value 

you specify 

[Claim Paid Amount] Greater 

than or equal to 500 

Less than Less than a value you specify [Claim Billed Amount] Less than 

200 

Less than or 

equal to 

Less than or equal to a value you 

specify 

[Claim Billed Amount] Less than 

or equal to 200 

Between Between two values you specify 

that includes those two values 

[Date of Birth] Between 1/1/1950 

and 12/31/1980 

Not between Outside the range of two values 

you specify 

[Date of Birth] Not between 

1/1/1900 and 12/31/1950 

In list The same as multiple values you 

specify 

[Zip Code] In list 43754, 44301, 

45856 

Not in list Different from multiple values 

you specify 

[Zip Code] Not in list 43754, 

44301, 45856 

Is null For which there is no value 

entered in the database 

[First Name] Is null 

Is not null For which there is a value 

entered in the database 

[First Name] Is not null 

Matches pattern For which there is a like value in 

the database 

[Procedure Code] Matches 

pattern D% 

Different from 

pattern 

For which there is not a like value 

in the database 

[Procedure Code] Different from 

pattern D% 
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Note: The descriptions above are based on information found in the BusinessObjects user 

manual Performing On-Report Analysis with Web Intelligence, Chapter 14: Filtering Results 

on Reports, pp. 214-216. Copyright 2004 by Business Objects. 

 

 

 


